IS362 Mastering the Basics of MS Project 2010

March 2012

Information Technology Skills Series
### TABLE OF CONTENTS

**MICROSOFT PROJECT 2010**

- **What is Project 2010?** .............................................................. 3  
  - Project 2010 .............................................................................. 3  
- **Installing the Sample Files** ....................................................... 3
- **The Project 2010 Environment** .................................................. 4  
  - Starting Project 2010 .................................................................. 4  
  - The Gantt Chart View ................................................................ 4  
  - How the Gantt Chart Displays Information .............................. 5

**Defining the Project**

- Starting a New Project .................................................................. 7  
- **Entering Start and Finish Dates** ................................................ 7
  - Inputting Start and Finish Dates ................................................ 7

**Saving the Project**

- Entering Tasks ............................................................................. 9
  - Automatic verses Manual Scheduling ..................................... 9
  - Entering Tasks ....... ................................................................. 10  
- Entering Subtasks ....................................................................... 10
  - Entering Subtasks ................................................................... 10
  - Editing the Notes for a Task .................................................... 12
  - Inserting, Moving and Deleting Tasks ................................. 12

**Creating Dependencies**

- Establishing Dependencies ....................................................... 13
  - How to create a Dependency .................................................. 13

**Resources**

- Creating a Resource List ............................................................ 16
  - Creating Resources .................................................................. 16
  - Using the Resource Sheet View ............................................. 16
  - Setting the Resource Type .................................................... 18

**Entering Working Time**

- Entering Working Time ............................................................ 19
  - Entering Costs ......................................................................... 20
  - Entering Rates ......................................................................... 20
  - Assigning Resources .............................................................. 21

**Updating and Tracking Projects**

- Setting the Baseline .................................................................... 22
  - Understanding Baselines ..................................................... 22
  - Opening the Project File ....................................................... 22
  - Setting the Baseline ............................................................... 22

**Recording Actuals - Tasks**

- Setting Actual Start and Finish Dates .................................... 23
  - Setting Actual Task Durations .............................................. 23

**Views**

- Introduction to Views ............................................................... 26
  - Using the Task Usage View ................................................... 26
  - Using the Calendar View ....................................................... 27
CREATING A NEW PROJECT ................................................................. 28
  Creating a New Project ................................................................... 28
  Starting a New Project ................................................................... 28
  Inputting Start and Finish Dates .................................................... 28
SAVING THE PROJECT ........................................................................ 29
ENTERING TASKS .................................................................................. 29
  Automatic verses Manual Scheduling ........................................... 29
  Entering Tasks ................................................................................. 30
ENTERING SUBTASKS ........................................................................... 32
  Entering Subtasks .......................................................................... 32
CREATING DEPENDENCIES ................................................................. 34
  Establishing Dependencies ............................................................ 34
  To create the Dependencies ............................................................ 34
CREATING A RESOURCE LIST ............................................................. 35
  Creating Resources ......................................................................... 35
  Using the Resource Sheet View ...................................................... 35
ENTERING WORKING TIME ................................................................. 37
  Entering Working Time ................................................................... 37
ENTERING COSTS .................................................................................. 38
  Entering Rates ................................................................................ 38
ASSIGNING RESOURCES ...................................................................... 38
WORKING WITH BASELINES .............................................................. 40
  Understanding Baselines ................................................................. 40
SETTING THE BASELINE .................................................................... 40
RECORDING ACTUALS - TASKS ........................................................... 40
  Setting Actual Start and Finish Dates ............................................. 40
  Actual Task Durations ..................................................................... 41
TRACKING WITH THE TRACKING GANTT VIEW .................................. 42
  Utilizing the Tracking Gantt View .................................................. 42
APPENDIX ......................................................................................... 43
  CHANGING THE WORKING TIME WITHIN A PROJECT .................... 43
  CHANGING A RESOURCE TO INCLUDE SPECIFIC OVERTIME ........ 44
SHUTTING DOWN ............................................................................... 46
CONCLUSION ....................................................................................... 46
Microsoft Project 2010

What is Project 2010?

Project 2010

- **Microsoft Project 2010** is Microsoft's answer to project management. It provides all the tools you need for effective **planning**, **tracking**, **problem solving**, **sharing**, and **completing** a project in keeping with conventional management principles and practices.

  It can be used for a project of any size. It simply provides a framework to start with, as well as the means to organise and manage effectively. It is like having a project management assistant.

- **In this session** you will learn how to use the basic features of Microsoft Project to manage your projects. By the end of the session you will be able to:
  - Enter tasks and their duration
  - Modify tasks
  - Create dependencies between tasks
  - Create a list of resources and assign them to tasks

Installing the Sample Files

- Before we begin this session we first need to **copy** the files that we will be using during this session from the (R:) drive onto our (Y:) drive. To do this:
  - Click on the **Start** button.
  - Click on **Programs**.
  - Click on **Accessories**
  - Click on **Windows Explorer**.
  - Click on the down-arrow alongside the **Address** panel and select the (R:) drive.
  - In the right-hand pane scroll down to find the **IT Training** folder, then double-click on it to expand it.
  - Right-click on the **Project 2010 Workbook Files** folder and choose **Copy**.
  - In the left-hand pane, scroll down to locate your (Y:) drive then, if necessary, expand it by clicking on the plus sign to its left.
  - Right-click on your **IT Skills** folder and choose **Paste**.
    - The **Project 2010 Workbook Files** folder will be pasted into this folder.
  - Close **Windows Explorer** by clicking on its **Close** button ☒.
The Project 2010 Environment

Starting Project 2010

- We will begin by opening Project 2010. To do this in the Admin Training Room:
  - Click on **Start**.
  - Click on **Programs**.
  - Click on **Microsoft Office**.
  - Click on **Microsoft Office Project 2010**.

- Project 2010 opens with a new blank project displayed in the default **Gantt Chart** view.

- We will now open one of the Project files that we saved earlier to our (Y:) drive, so to do this:
  - Click on **File** tab at the left of the **Ribbon**.
  - Click on **[Open]** to display the **Open** dialogue box.
  - Click on the down-arrow to the right of the **Look in** box.
  - If the (Y:) displays click on it to select it. If it does not display:
    - Click on **Desktop**.
    - Double-click on **My Computer**.
    - Double-click on **Home on My Data (Y:)**.
    - In the list of folders that appears below, double-click on the **IT Skills** folder.
    - Double-click on the **Project 2010 Workbook Files** folder.
    - Click on the **New Product Brochure – Views.mpp** file to select it, then click on **[Open]** to open the file.

The Gantt Chart View

- The Project file has been opened in **Gantt Chart** view.

- The **Gantt Chart** view is Project’s default view. It consists of a **Gantt table** (on the left) and a **Gantt Chart** (on the right). The **Gantt table** is made up of columns of information, and the **Gantt Chart** is the graphic representation of the information entered.
• The Gantt Chart view is useful for entering task information and for viewing the timing and relationship between tasks.

• The Gantt table on the left displays information in columns such as:
  o Task Name – showing the different tasks and subtasks which are involved in the project
  o Duration, Start and Finish - The estimated duration of each of the tasks or subtasks, including start and finish dates
  o Predecessors – Indicates the relationship of a subtask to other tasks, if any exists
  o Resource Names – displays the resources assigned to each task or subtask, e.g. personnel or materials.
    Note: we will consider each of these categories in more detail later on in this session.

• The two windows on your screen can be resized so that you can view a larger or smaller portion of the window. To resize, simply hover your mouse cursor over the grey vertical divider until it becomes a double-headed arrow. Click and drag the line until it is in the position you desire.
  o Practice this now by clicking and dragging the vertical divider to the left, to decrease the size of the Gantt table on the left, and increase the size of the Gantt Chart on the right.

How the Gantt Chart Displays Information

• You will notice that the Gantt Chart displays different types of task in different ways. The most common of these are outlined below:

<table>
<thead>
<tr>
<th>Type of Task</th>
<th>Description</th>
<th>Gantt Chart Representations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>All tasks that are not milestones or summary tasks.</td>
<td>Blue bar</td>
</tr>
<tr>
<td>Milestone</td>
<td>Either a task with a zero duration, or a task that has been designated as a milestone.</td>
<td>Black diamond</td>
</tr>
<tr>
<td>Summary</td>
<td>Tasks that represent the duration of the tasks subordinate to them in an outline.</td>
<td>Black bar</td>
</tr>
<tr>
<td>Critical*</td>
<td>A task or series of tasks that must be completed on schedule in order for a project to finish on schedule.</td>
<td>Red bar</td>
</tr>
<tr>
<td>Finished</td>
<td>Tasks for which an actual finish date has been entered or that have been marked 100% complete.</td>
<td>Blue bar with black centre</td>
</tr>
<tr>
<td>In Progress</td>
<td>Tasks for which an actual start date but not an actual finish date, has been entered.</td>
<td>Blue bar with black progress line</td>
</tr>
</tbody>
</table>
*Note:* to view the **critical** tasks in **Gantt Chart** view you need to display the **Detail Gantt** chart. To do this:

- Click on the **View** tab towards the centre of the **Ribbon**.
- Click on the down-arrow to the right of **Other Views** in the **Resource Views** group towards the centre of the **Ribbon**.
- Click on **More Views**.
- Select **Detail Gantt** in the **More Views** dialogue box.
- Click on **[Apply]**.

![More Views dialog box]

- Now close the file, by clicking on the lower grey **Close** button at the top right of the screen.
- When the dialogue box appears asking you if you would like to save the changes, choose **[No]**.
Defining the Project

Starting a New Project

- We will now start a new project; to do this:
  - Click on the File tab at the left of the Ribbon.
  - Click on New.
  - Double-click on Blank project below the Available Templates heading.

Note: Alternatively you may use the default blank presentation that displays when Project is first accessed. However, it may be preferable to follow the above procedure if you wish to be sure that the file is completely new.

Entering Start and Finish Dates

Inputting Start and Finish Dates

- The first step in starting a new project is establishing basic project information. The start or finish date is what you will use to anchor your project. Your schedule will be built around either the start date or the finish date that you choose.

- The start and finish date information is entered in the Project Information dialogue box, which we will open now. To do this:
  - Click on the Project tab around the centre-left of the Ribbon.
  - Click on Project Information in the Properties group at the left of the Ribbon to display the Project Information dialogue box.
Depending on what you choose from the **Schedule from**: drop-down menu (**Project Start Date** is the default), either the **Start date:** or **Finish date:** will be available for you to enter a date into.

- You can either **type** in the date, or click the down-arrow to display a pop-up **calendar** to select a date.

- Typically, the other fields (**Current date:**, **Status date:** and **Calendar:**) can be left as the default values.
- In this case use the drop-down calendar in the **Start date:** field to select **Monday, February 20, 2012**

- We will also set the **Current date:** so that we can easily see the project’s start date. Therefore use the drop-down calendar in the **Current date:** field to change the date to **Sunday, February 19, 2012**

- Project supplies three basic calendars (**Standard**, **Night Shift** and **24 Hours**)  
  - In this case ensure that **Standard** is selected from the **Calendar:** drop-down menu.

- Click **[OK]** to close the **Project Information** dialogue box.
- You will be returned to the **Gantt Chart** view where you will notice that the dates you specified in the **Project Information** dialogue box are now displayed in the **Gantt Chart**.

- **Note:** The **Status date:** is used to record when the project was updated to reflect changes in task durations, costs etc, and is used to identify differences between what was expected and what actually happened.

- **It should be noted that all of this** information can be changed at any time throughout your project, which can be useful in trying out "what-if" scenarios in the planning stage.
**Saving the Project**

- Before we go any further, we will save our new project to the **Project 2010 Workbook Files** folder that we earlier saved to our (Y:) drive. To do this:
  - Click on the **File** tab at the left of the **Ribbon**.
  - Click on **Save As** to open the **Save As** dialogue box.
  - Click on the down-arrow to the right of the **Look in:** box.

  - If the (Y:) displays click on it to select it. If it does not display:
    - Click on **Desktop**.
    - Double-click on **My Computer**.
    - Double-click on **Home on My Data (Y:)**.

  - In the list of folders that appears, double-click on the **IT Skills** folder.
  - Double-click on the **Project 2010 Workbook Files** folder.
  - Type the name **New Product Brochure** in the **File name:** panel.
    - **Note:** Notice that the file extension for a Project file is *.mpp
  - Click on **[Save]**. Tasks

**Entering Tasks**

**Tasks** are the specific activities that must be completed in order to finish your project (i.e. a 'to-do' list).

Your task list is the backbone of your project plan. It is essential to create your task list as comprehensively as possible because if a required task is omitted, you may not be able to achieve all of your goals. It is beneficial to create your task list in approximately the same order as the tasks will be performed, although it is not necessary to be completely accurate as there are ways to **edit**, **add**, **delete** and **move** tasks.

**Automatic verses Manual Scheduling**

- In contrast to previous versions which automatically arranged the scheduling of tasks, Project 2010 offers the facility to manually arrange the scheduling of tasks.

- This may be useful where you want full control over the scheduling of your project’s task. However, for our current project we will let Project do the scheduling for us.

- As Project 2010 applies Manual Scheduling by default we now need to change this to Automatic Scheduling. To do this:
  - Click on the **New Tasks: Manually Scheduled** button at the left of the status bar at the bottom of the screen.
  - Select **Auto Scheduled – Task dates are calculated by Microsoft Project** from the menu that displays.
Entering Tasks

- There are a couple of ways to enter a new task. The first is to click in the **Task Name** column in the first empty row of the **Gantt table** and enter the task name.

  We will now use this method to enter our first task:
  - Click in the top row of the **Task Name** column of the **Gantt table**.
  - Type: **Write Brochure**
  - Press [Enter]. The task is entered into the **Gantt table**.

- After you accept the information, the task is assigned an **ID number** that is displayed in the far left column. This is useful for establishing relationships between tasks, such as successors and predecessors.

- Project uses **1 day** as the default length for estimated task durations. Project notifies you that this is an estimated date by displaying a question mark (?) at the end of the entry.

  If your estimate for the duration of your task is different than one day, you can change it, however we will leave these default start and finish dates as they are for now (amending start and finish dates will be covered later on in this session).

<table>
<thead>
<tr>
<th>Task Mode</th>
<th>Task Name</th>
<th>Duration</th>
<th>Start</th>
<th>Finish</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Write Brochure</strong></td>
<td>1 day?</td>
<td>Mon 20/02/12</td>
<td>Mon 20/02/12</td>
</tr>
</tbody>
</table>

**Note:** the other type of duration that project can display is an **actual** duration, which shows the span of actual working time for a task so far, in other words once a task is actually underway.

- Click on **Save** in the **Quick Access Toolbar** at the top-left of the screen to save the changes.

Entering Subtasks

- **Subordinate tasks**, or **subtasks**, are used to break large tasks into smaller units until you reach the level of detail you want. This can be useful in the displaying and printing of your project.

- By breaking large tasks into smaller, more manageable tasks, you may be able to schedule them to run concurrently, and thereby reduce both the duration of the task and the duration of the project.

- We will now enter the task to Research the New Product, which is a subtask of the **Write Brochure**. To do this:
  - Click in the **Task Name** cell below the **Write Brochure** task.
  - Type: **Research New Product**
  - Press [Enter] to accept the new task.

- We now need to make our new task a **subtask** of the **Write brochure** task. To do this:
  - Ensure that **Research New Product** is selected by clicking on it if necessary.
Click on the **Task** tab at the left of the **Ribbon**.
Click on the **Indent Task** button in the **Schedule** group at the centre-left of the **Ribbon**.

You should notice that the higher-level task (Write Brochure) has now become what is known as the **summary** task, and its representation in the **Gantt Chart** has changed to reflect this.

- **We will now add another subtask, to do this:**
  - Click in the **Task Name** column, in the next empty cell beneath the **Research New Product** task.
  - Type: **Create an Outline**
  - Press `[Enter]` to accept the entry.

  **Note:** Notice that this task has been automatically entered as a subtask.

- **Another way to enter a task is to use the Task Information dialogue box,** which we will use now to create another subtask.
  One advantage to using this dialogue box is that it includes access to the **Notes** pane, which can be very useful for adding details about the task. For example you can include details of when the task was set up and any changes made to it during the project’s progress.

- **We will now add another task using this dialogue box. To do this:**
  - Double-click in the **Task Name** column, in the next empty cell beneath the **Create an Outline** task to display the **Task Information** dialogue box.

  **Note:** This can also be displayed by clicking on the **Information** button in the **Properties** group at the right of the **Task** tab.

  - Ensure that the **General** tab is selected.
  - In the **Name:** panel type: **Write a Rough Draft**
  - Now click on the **Notes** tab and enter details of who and when this task was created, for example:
    - **Created by Ann Nonymouse 20/02/2012**
  - When you have finished click on **[OK]** to return to the **Gantt Chart**.
  - You should notice that the new task has been added to the **Gantt table** list, and has also appeared as a blue square in the **Gantt Chart** on the right.
You should also notice that a Notes icon has been added in the Information column to the left of the Create an Outline task.

**Note:** The Notes pane can be easily displayed, for example to enter updates, by clicking on the Notes button in the Properties group at the right of the Task tab on the Ribbon.

- Click on Save in the Quick Access Toolbar at the top-left of the screen to save the changes.

**Editing the Notes for a Task**
- Once a Note has been added to a task it is easy to edit it, for example to include updated details. To do this:
  - Double-click on the Notes icon in the Information column to the left of the Create an Outline task.
  - The Task Information dialogue box opens displaying the Notes pane.
  - Make any necessary changes and when you have finished click on click on [OK] to close the dialogue box.

**Inserting, Moving and Deleting Tasks**
- **To insert an additional task between two existing tasks**
  - Right-click on the ID number below the position you want to insert the new task. Therefore, in this case, right-click on the ID number 3 to the left of the Create an Outline task name.
  - Select Insert Task from the menu that displays. A new blank row is created.
  - Click within the new cell under the Task Name heading to obtain an insertion point.
  - Enter the name for the new task, which in this case is: test
  - Press [Enter] to accept the change.

- **To move a task**
  - Click on the ID number for the task that you want to move to select the entire row. In this case click on the ID number for the test task that you have just created.
  - Now click again on the ID number and drag the task to its new position. As you do so a grey horizontal bar displays to indicate where the task will be positioned.
  - In this case position it so that it is between the Write brochure and Research New Product tasks.
  - When you are happy that it is in the correct place release the mouse button.

- **To delete a task**
  - Click on the ID number for the task that you want to delete. In this case select the ID number for the test task that you have just moved.
  - Press [Delete] on the keyboard. The task is deleted.

That completes our work on this project so close it by clicking on its lower grey Close button. When you are prompted to save the changes click on [No].
Creating Dependencies

Establishing Dependencies

- **Dependencies** are a way to link tasks together in order to describe which tasks must precede or succeed one another – in other words, **some tasks must start or finish before another task can begin or end**. Creating dependencies allows Project to create a flexible time framework relative to the task preceding or succeeding it.

- There are two types of tasks in a dependency. A **predecessor** task must occur before another task. A **successor** task must occur after another task.

- There are four different types of dependencies (or linkages) that can be assigned to a task or tasks. These are described below.

<table>
<thead>
<tr>
<th>Dependency</th>
<th>Description</th>
</tr>
</thead>
</table>
| **finish-to-start (FS)** | This is the most common type of relationship.  
The start of one task begins as soon as its predecessor finishes.  
The successor can't start until the predecessor finishes.  
E.g. A report must be finished before it can start to be edited. |
| **Start-to-Finish (SF)** | This requires the successor task is completed after its predecessor starts. 
That is, the successor task cannot finish until the predecessor task starts. 
This relationship is rarely used, although it may be necessary in unusual instances. 
E.g. Employees can start using a new procedure only after they have finished being trained. |
| **Start-to-Start (SS)** | This is where the successor cannot start until the predecessor starts.  
The tasks can happen simultaneously, but the predecessor has to have started in order for the successor to start.  
E.g. One you start to receive results you can start to process them. |
| **Finish-to-Finish (FF)** | This is where the successor can't finish until the predecessor finishes.  
The tasks can happen simultaneously, but the predecessor has to have finished in order for the successor to finish.  
E.g. The computer installation is finished at the same time as employees finish moving in so that they can start work immediately. |

How to create a Dependency

We will now open a previously created project file from our (Y:) drive and create a dependency within it. To do this:

- We will now open another one of the Project files that we saved earlier to our (Y:) drive, so to do this:
  - Click on the **File** tab at the left of the **Ribbon**.
  - Click on [**Open**] to display the **Open** dialogue box.
  - Click on the down-arrow to the right of the **Look in:** box.
If the (Y:) displays click on it to select it. If it does not display:
- Click on Desktop.
- Double-click on My Computer.
- Double-click on Home on My Data (Y:).
- In the list of folders that appears, double-click on the IT Skills folder.
- Double-click on the Project 2010 Workbook Files folder.

Select New Product Brochure – Tasks from the list that appears and then click on [Open].

**Note:** you will notice that the project we are viewing is a more complete version of the project we began to create earlier.

We will now set up a dependency to specify that the Research New Product task must be completed before the Create an Outline task can begin. To do this:
- If necessary, use the scroll bar at the bottom of the Gantt Chart on the right-hand side of the screen to scroll to the left so that you can see the dates of the project in February 2012.

Double-click on the Create an Outline task in the Task Name column to display the Task Information dialogue box for that particular task.
- Click on the Predecessors tab.
- Click in the first row of the Task Name column to display a drop-down arrow.
- Select Research New Product from the drop-down list that appears.
- Now click in the first row of the Type column to display a drop-down arrow.
- Ensure that Finish-to-Start (FS) is selected from the drop-down menu.
- Click on [OK] to close the Task Information dialogue box.

You will notice that the ID number of the predecessor is shown in the Predecessors column of the Gantt table, and that the dependency is represented by an arrow that links the two subtasks in the Gantt Chart.

You will also see that the start and finish dates of the Create an Outline task have changed, to reflect the fact that it cannot start until its predecessor finishes.
We will now add two further predecessors to our task list. To do this:
- Double-click on the Write a Rough Draft task to open the Task Information dialogue box.
- Click on the Predecessors tab.
- Click in the first row of the Task Name column of the Predecessors tab. A drop-down arrow appears.
- Select Create an Outline from the drop-down list that appears.
- Now click in the first row of the Type column. A drop-down arrow appears.
- Ensure that Finish-to-Start (FS) is selected from the drop-down menu.
- Click on [OK] to close the Task Information dialogue box.

When applying Finish-to-Start dependencies you can also create them by clicking and dragging from the Predecessor Gantt bar to the Successor Gantt bar in the Gantt Chart.

To demonstrate this we will create a dependency between the Write a Rough Draft and Edit Rough Draft tasks. To do this:
- In the Gantt Chart on the right click on the Gantt bar for the Write a Rough Draft task so that a four-headed arrow displays.
- Now click and drag a link to the Edit Rough Draft task.

When a chain link icon displays, along with a panel on the right displaying the dependency details, release the mouse button to create the dependency.

We will not enter any further Predecessor information on this file.

Therefore close the New Product Brochure - Tasks.mpp by clicking on its lower grey Close button ❌. When you are prompted to save the changes click on [No].
Resources

Creating a Resource List

Creating Resources

- Resources are **people, supplies and equipment** that you need to use to accomplish your tasks and goals.

- Project uses the resource information you provide to make the **schedule** for your project – typically the more resources you assign, the shorter the duration of the project will be. This is because a task is completed faster when there are more people or materials assigned to it.

- To consider resources in more detail we will open another file that we saved earlier to our *(Y:)* drive, called **New Product Brochure – Resources**. To do this:
  - Click on the **File** tab at the left of the **Ribbon**.
  - Click on **[Open]** to display the **Open** dialogue box.
  - Click on the down-arrow to the right of the **Look in:** box.

  - If the *(Y:)* displays click on it to select it. If it does **not** display:
    - Click on **Desktop**.
    - Double-click on **My Computer**.
    - Double-click on **Home on My Data *(Y:)***.
  - In the list of folders that appears, double-click on the **IT Skills** folder.
  - Double-click on the **Project 2010 Workbook Files** folder.

  - Select **New Product Brochure – Resources** from the list that appears and then click on **[Open]**.

  **Note:** you will notice that the file we are viewing is a further completed version of the same project, with many more predecessors entered. As a result, the project is now extending over a much longer estimated time span.

Using the Resource Sheet View

- One of the best ways to enter resources is by using the **Resource Sheet** view, which we will open now. To do this:
  - Click on the **View** tab at the centre-left of the **Ribbon**.
  - Click on **Resource Sheet** (not the down-arrow) in the **Resource Views** group towards the left of the **Ribbon**.

- The **Resource Sheet** view is useful for viewing, entering and editing resource information. It contains detailed resource information in a **worksheet** format.
• We will now enter two resources into our project. This will involve entering a descriptive name for the resource in the **Resource Name** field. This can be a worker's name, a job title, or the name of a material. You also need to specify what **Type** of resource it is.

• We will now enter our first resource directly into the Resource Sheet. To do this:
  o Click in the first row of the **Resource Name** column.
  o Type: **Jane Smith**
  o Press **[Enter]** to accept the entry.

• Another way to enter resources is to use the **Resource Information** dialogue box. One advantage of using this method is that it includes a **Notes** pane, which can be useful for adding notes about the resource.

• We will now use the **Resource Information** dialogue box to add a resource for Postage. To do this:
  o Double-click in the **Resource Name** column in the next empty cell below **Jane Smith** to display the **Resource Information** dialogue box.
    **Note:** This can also be displayed by clicking on the **Information** button in the **Properties** group at the right of the **Resource** tab.
  
    o In the **Resource name:** panel type: **Postage**
    o Now, to add a Note about this resource, click on the **Notes** tab and enter: **Created by Ann Nonymouse 20/02/2012, Postage to be arranged with Royal Mail.**
    o When you have finished click on **[OK]**.

  o You will be returned to the **Resource Sheet** where you will notice that the Postage resource has been added below Jane Smith. You should also notice that a **Notes** icon has been added in the Information column to the left of the Postage resource.
    **Note:** The resources **Notes** pane can be easily displayed, for example to enter updates, by clicking on the **Notes** button in the **Properties** group at the centre of the **Resources** tab on the **Ribbon**.
Setting the Resource Type

- Once you have entered a resource you should notice that Project has assigned some default values to the resource, of which one of these is the resource **Type**.
- Project allows you to choose either **Work** (human resources), **Material** or **Cost** as the resource **Type**.

  **Note:** Do be aware that if the file is viewed in Project 2003 any **Cost** type is converted to **Material**. Therefore do not use this option if sharing the file with anyone using this earlier version.

- We will now change the resource Type for **Postage** to **cost**. To do this:
  - Click in the **Type** column to the right of **Postage**.
  - Select **Cost** from the drop-down list.
  - Click anywhere away from the cell you have just updated.

- Click on **Save** in the **Quick Access Toolbar** at the top-left of the screen to save the changes.
**Entering Working Time**

**Entering Working Time**

- Where necessary you can customise a resource's availability during the project by modifying their project calendar.

- We will now customise the calendar for Jane Smith to record that she is having a day's leave on a normal working day during the project. To do this:
  - Open the Resource Information dialogue box by double-clicking on the Resource Name Jane Smith in the Resource Sheet.
  - Click on the General tab and click on the [Change Working Time] button at the right of the dialogue box.
  - Ensure that Standard is selected in the Base calendar: panel.
  - If necessary use the scroll bar to the right of the calendar to scroll to February 2012.
  - Click on the date 21 February 2012. This is going to be an Exception Day i.e. a day away from work, or nonworking day, for our resource.
  - Ensure the Exceptions tab towards the bottom of the dialogue box is selected.
  - Click in the Name panel and type in a reason for not being available on that date. In this case enter Day off.
  - Click in the panel at the right under the Start heading. 21 February 2012 will automatically be entered.
  - **Note:** If this occurs regularly, click on [Details] to the right of the panel and specify how often this occurs in the Recurrence pattern panel.
  - Click on [OK] to close the Change Working Time dialogue box.
  - Click on [OK] to close the Resource Information dialogue box.
Entering Costs

Entering Rates

- It is important to enter **rates** for a resource, even if they are estimates, as this allows Project to calculate the overall cost of a project.
- The cost of a resource may increase or decrease during the life of your project, and you need to be able to reflect these changes.

- We will now enter some rates for our resource **Jane Smith**. To do this:
  - In the **Resource Sheet** double-click to select the **Std. Rate** cell for the resource **Jane Smith** to open the **Resource Information** dialogue box.
  - Click on the **Costs** tab.

  ![Resource Information Dialogue Box]

  - Type **20** in the **Standard Rate** column to record that her normal pay rate is £20 per hour.
  - Press [Enter] to accept the entry.
  - Type **30** in the **Overtime Rate** cell.
  - Press [Enter] to accept the entry.
  - When you have finished click on [OK] to close the dialogue box.

- Click on **Save** in the **Quick Access Toolbar** at the top-left of the screen to save the changes.
Assigning Resources

- Now we have entered some resources information we can assign these resources to particular parts of the project. To do this:
  - Begin by redisplaying the Gantt Chart by clicking on the View tab at the centre left of the Ribbon.
  - Then click on Gantt Chart (not the down-arrow) in the Task Views group at the left of the Ribbon.
  - In the Gantt Chart view, click on the Resource Names column for the Research New Product task.
    **Note:** If necessary resize the Gantt table to fully view the Resources Names column by dragging the vertical divider to the right.
  - Click on the down-arrow and select Jane Smith from the list that displays to associate her to this task.
  - Press [Enter] to accept the change.

- Another way of achieving this is by using the Task Information dialogue box. To use this method to associate the Postage resource to the Do mass mail out task:
  - Double-click on the Do mass mail out task to open the Task Information dialogue box.
  - Click on the Resources tab.
  - Click within the first blank cell below the Resource Name heading to obtain an insertion point and then click on the drop-down arrow that appears to the right of the panel.
  - Select Postage from the drop-down list.
  - Click [OK] to close the dialogue box.

- You will notice that the names of the resources that you have assigned have appeared in the Gantt Chart to the right of the tasks to which they relate.
- Now close the file, by clicking on its lower grey Close button. When the dialogue box appears asking you if you would like to save your changes, choose [No].
Updating and Tracking Projects

Setting the Baseline

Understanding Baselines
- The baseline is a picture or image you capture of the project plan the moment planning is complete.
- It is used to track the planned progress of the project against the actual progress. It provides a point of reference when tracking your project.
- With smaller projects, one baseline is usually sufficient because planning is usually close to what actually happened. With larger projects, however, several baselines may be required because projects can move far off the planned path. Project 2010 allows you to save 11 different baselines and 11 interim plans.

Opening the Project File
- We will now open another file we saved previously to our (Y:) drive and set the baseline for our project. To do this:
  o Click on the File tab at the left of the Ribbon.
  o Click on [Open] to display the Open dialogue box.
  o Click on the down-arrow to the right of the Look in: box.
  o If the (Y:) displays click on it to select it. If it does not display:
    - Click on Desktop.
    - Double-click on My Computer.
    - Double-click on Home on My Data (Y:).
  o In the list of folders that appears, double-click on the IT Skills folder.
  o Double-click on the Project 2010 Workbook Files folder.
  o Select New Product Brochure – Updating and Tracking from the list that appears and then click on [Open].

  Note: you will notice that the project we are viewing is a more complete version of the project we have been working on throughout this session.

Setting the Baseline
- We will now set a Baseline to record the current position of the project. To do this:
  o Click on the Project tab towards the left of the Ribbon.
  o Click on Set Baseline in the Scheduling group at the centre of the Ribbon to display a menu.
  o Select Set Baseline to display the Set Baseline dialogue box.
Ensure that the **Set Baseline** check box displays a check mark.

![Set Baseline dialog box](image)

In this case we want to record the entire project, so ensure that the **Entire project** check box under the **For:** heading displays a check mark.

Click **[OK]** to save the baseline information and close the dialogue box.

---

**Recording Actuals - Tasks**

- Once a project is underway, it is important to collect and record data on task progress to show what has **actually** occurred. This allows Project to automatically reschedule the remaining tasks and gives tangible ways to measure progress (when compared to the baseline).

- when **updating** and **recording actuals** the **Gantt Chart** is the best view to work from.

---

**Setting Actual Start and Finish Dates**

- Recording the **actual** start or finish date of a task is critical to the overall finish date of the project. If tasks are finishing on time, the project is likely to finish on time, and conversely, if tasks are completed behind schedule, the project is likely to finish behind time.

- We will now record the actual start date and status of the **Research New Product** task. To do this:
  1. Click on the **Task** tab at the left of the **Ribbon**.
  2. Click on the **Display Task Details** button at the right of the **Properties** group on the **Ribbon**.

    ![Task Details Form](image)

- The **Task Details Form** appears in the bottom half of the screen.
In the top pane of your screen, select the **Research New Product** task by clicking within it in the **Task Name** column.

We wish to specify the actual date this task started, therefore in the bottom pane, choose **Actual** from the option buttons at the bottom of the **Dates** panel.

We need to state that this task **did** begin on Monday. So click on the drop-down calendar in the **Start:** panel within the **Dates** section and select **Monday 20 February 2012** as the actual start date.

We will also record that the task is now 100% complete. So to do this click on the up/down arrows to the right of the **% complete:** text box toward the right of the dialogue box so that it displays **100%**.

When you have finished click on **[OK]** at the top of the dialogue box to accept the changes.

- You will notice a tickmark has appeared in the **Information** column next to the **Research New Product** task in the top half of the screen. This indicates that the task has been completed.
- The **Gantt Chart** entry also displays a full black band in the **Research New Product** task, indicating that it is complete.
  
**Note:** You may need to scroll across to the right to see the date area for **20th February 2012**.

We no longer need the Task Details Form, therefore to remove it and view the Gantt Table and Chart in full screen mode:

- Click on the **Task** tab at the left of the **Ribbon**.
- Click on the **Display Task Details** button at the right of the **Properties** group on the **Ribbon**.
Setting Actual Task Durations

- In a similar way, it is possible to record the actual duration of tasks, which we will now do for the Create an Outline task. To do this:
  - Begin by clicking on the task you would like to update to select it.
  - In this case click on Create an Outline in the Task Name column.
  - Click on the Task tab at the left of the Ribbon.
  - Click on the down-arrow to the right of the Mark on Track button in the Schedule group at the centre of the Ribbon to display a menu.
  - Select Update Tasks to display the Update Tasks dialogue box.
  - We need to specify that the duration of the Create an Outline task was two days, not one as expected.
  - Therefore use the up-arrow to the right of the Actual dur: option box to change the actual duration of this task to 2d (2 days).
  - Click [OK] to accept the change and close the dialogue box.
  - You will notice a tick mark has appeared in the Information column next to the Create an Outline task at the top of the screen, indicating that the task has been completed.
  - You will also see that the duration has changed to 2 days, and that subsequent dates have been altered to reflect that this part of the Project took longer than originally planned.
  - **Note:** You may need to scroll across to the right to see the date area for 20\textsuperscript{th} February 2012.

- Click on Save in the Quick Access Toolbar at the top-left of the screen to save the changes.
Views

Introduction to Views

- Project includes a number of different Views, which enable you to see the project from a variety of perspectives and focus on different aspects.
- So far we have used the Gantt Chart view, which is the default view, and the Resource Sheet view.
- Two other views we will look at now are Task Usage and Calendar.
- You can use most views to enter and edit information, although some views can only display information.

- The Views available can all be accessed from the More Views dialogue box, which can be accessed by clicking on the down-arrow on most of the view buttons.
- For example, to do this:
  - Click on the down-arrow at the bottom of the Gantt Chart button at the left of the Task or View tab on the Ribbon.
  - Select More Views from the bottom of the menu that displays.
  - We will not use this dialogue box, so close it by clicking on [Cancel].

Using the Task Usage View

- The Task Usage View can be considered to be a composite of the Gantt Table and the Properties Sheet, as it displays both the tasks and the associated resources together.
- To access this from its own button:
  - Click on the View tab at the centre-left of the Ribbon.
  - Click on Task Usage button (not the down-arrow) in the Task Views group at the left of the Ribbon.

- When you have finished return to the Gantt Chart view by clicking on Gantt Chart (not the down-arrow) in the Task Views group at the left of the Ribbon.
Using the Calendar View

- The calendar view is useful for a general overview of what needs to be done on a specific day.
- To access this from its own button:
  o Click on the View tab at the centre-left of the Ribbon.
  o Click on Calendar button (not its down-arrow) in the Task Views group at the left of the Ribbon.

- When using this the main points to consider are:
  o You can switch from Monthly view to Weekly view by clicking on the buttons at the top-left of the actual calendar.
  o You can scroll through the months by using the arrow buttons immediately below the Month/Week buttons.
  o A black box surrounds the current date.
  o Tasks are shown by a bar stretching over the amount of days allocated for the task.
  o A solid black bar shows the project’s milestones.
  o You can double-click on any of the tasks to open the Task Information dialogue box and view specific information about that task.

- That completes our work on this project, so close the file by clicking on its lower grey Close button  . When the dialogue box appears asking if you would like to save the changes, click on [No].
Creating a New Project

Creating a New Project
- We will now use the features that we have just covered to create a new project to manage a room move scenario. We will therefore create a small number of tasks, create dependencies between them, and create a resource list.

Starting a New Project
- We will now start a new project; to do this:
  - Click on the File tab at the left of the Ribbon.
  - Click on New.
  - Double-click on Blank project below the Available Templates heading.

Inputting Start and Finish Dates
- The first step in starting a new project is establishing basic project information. The start or finish date is what you will use to anchor your project. Your schedule will be built around either the start date or the finish date that you choose.
- The start and finish date information is entered in the Project Information dialogue box, which we will open now. To do this:
  - Click on the Project tab around the centre-left of the Ribbon.
  - Click on Project Information in the Properties group at the left of the Ribbon to display the Project Information dialogue box.

- We will set the project to begin today, so click on the drop-down arrow to the right of the Start date: panel and then click on the Today: entry at the bottom of the calendar that displays.
- We will leave all the other fields as their default values for now.
- Click [OK] to close the Project Information dialogue box. You will be returned to the Gantt Chart view where you will notice that the dates you specified in the Project Information dialogue box are now displayed in the Gantt Chart.
Saving The Project

- Before we go any further, we will save our new project to the Project 2010 Workbook Files folder that we created earlier on our (Y:) drive. To do this:
  - Click on the File tab at the left of the Ribbon.
  - Click on Save As to open the Save As dialogue box.
  - Click on the down-arrow to the right of the Look in: box.
  - If the (Y:) displays click on it to select it. If it does not display:
    - Click on Desktop.
    - Double-click on My Computer.
    - Double-click on Home on My Data (Y:).
  - In the list of folders that appears, double-click on the IT Skills folder.
  - Double-click on the Project 2010 Workbook Files folder.
  - Type the name Room Move in the File name: panel.
    - Note: Notice that the file extension for a Project file is *.mpp
  - Click on [Save].

Entering Tasks

Tasks are the specific activities that must be completed in order to finish your project (i.e. a 'to-do' list). Your task list is the backbone of your project plan. It is essential to create your task list as comprehensively as possible because if a required task is omitted, you may not be able to achieve all of your goals. It is beneficial to create your task list in approximately the same order as the tasks will be performed, although it is not necessary to be completely accurate as there are ways to edit, add, delete and move tasks.

Automatic verses Manual Scheduling

- In contrast to previous versions which automatically arranged the scheduling of tasks, Project 2010 offers the facility to manually arrange the scheduling of tasks.

- In this case we will set Project to let it do the scheduling for us. To do this:
  - Click on the New Tasks: Manually Scheduled button at the left of the status bar at the bottom of the screen.
  - Select Auto Scheduled – Task dates are calculated by Microsoft Project from the menu that displays.
Entering Tasks

- There are a couple of ways to enter a new task. Possibly the easiest is to click in the Task Name column in the Gantt table and enter the task name.
- It is generally useful to be able to see the Duration and Start columns in the Gantt table when entering tasks. Therefore if you cannot see these columns click and drag the vertical bar between the Gantt table and Gantt Chart to the right to make them visible.

- To enter our tasks:
  o Click in the top cell of the Task Name column of the Gantt table.
  o Type: Get Skip
  o Press [Enter] to enter the task into the Gantt table.

  o You should notice that a blue rectangle to represent this task now displays under today’s date in the Gantt Chart on the right-hand side of the screen.
  o Also, as we have enabled Automatic Scheduling, project has entered the estimated duration of 1 day into the Duration cell.

  o We will now add a Note to this task stating when it was created, so to do this:
    ▪ Click on the Get Skip task name.
    ▪ Click on the Notes button in the Properties group at the right of the Task tab on the Ribbon.
    ▪ Enter: Created by (your name) 20/02/2012
    ▪ Click on [OK] to close the Task Information dialogue box.

  o In the next row down of the Task Name column enter the next task, which is: Empty room
  o Press [Enter] to accept the task and add it to the Gantt Chart.

  o This task is expected to take only half a day, rather than the one day that has been automatically entered.
Therefore to change this click on the Duration column and overtype the value with: 0.5
  o Press [Enter] to accept the change.

  o Now add a Note to this task stating when it was created:
    ▪ Click on the Empty room task name.
    ▪ Click on the Notes button in the Properties group at the right of the Task tab on the Ribbon.
    ▪ Enter: Created by (your name) 20/02/2012
    ▪ Click on [OK] to close the Task Information dialogue box.

  o Now enter the next task, which is: Wire room and then press [Enter].
  o Add a Note to this task stating when it was created:
    ▪ Click on the Wire room task name.
    ▪ Click on the Notes button in the Properties group at the right of the Task tab on the Ribbon.
    ▪ Enter: Created by (your name) 20/02/2012 then click on [OK].
Enter the fourth task which is: Decorate then press [Enter].

Now set the duration for this task to be 3 days by clicking in the Duration cell and overtype the value with: 3

Press [Enter] to accept the change.

Now add a Note to this task stating when it was created:
- Click on the Decorate task name.
- Click on the Notes button in the Properties group at the right of the Task tab on the Ribbon.
- Enter: Created by (your name) 20/02/2012
- Click on [OK] to close the Task Information dialogue box.

Finally, enter the last task which is Move in furniture, which in this case we will create using the Task Information dialogue box. To do this:
- Double-click in the Task Name column, in the next empty cell beneath the Decorate task to display the Task Information dialogue box.
- Select the General tab.
- In the Name: panel type: Move in furniture

- Now click on the Notes tab and enter details of who and when this task was created, for example: Created by (your name) 20/02/2012
- When you have finished click on [OK] to return to the Gantt Chart.

Click on Save in the Quick Access Toolbar at the top-left of the screen to save the changes.
Entering Subtasks

Subordinate tasks, or subtasks, are used to break large tasks into smaller units until you reach the level of detail you want. This can be useful in the displaying and printing of your project.

We will now create two subtasks, Install electrics and Network for the Wire room task. To do this:
- Right-click on the ID number below the position you want to insert the new task. Therefore, in this case, right-click on the ID number 4 to the left of the Decorate task name.
- Select New Task from the menu that displays. A new blank row is created.
  - Click within the new cell under the Task Name heading to obtain an insertion point.
  - Enter the name for the new task, which in this case is: Install electrics
  - Press [Enter] to accept the change.
  - We wish to make this a subtask of the Wire room task, so again click on the Install electrics task.
- Click on the Task tab at the left of the Ribbon.
- Click on the Indent Task button in the Schedule group at the centre-left of the Ribbon.
  - The higher-level task has now become a summary task and its representation in the Gantt Chart changed to reflect this.

We will now add a Note to this task stating when it was created, so to do this:
- Click on the Install electrics task name.
- Click on the Notes button in the Properties group at the right of the Task tab on the Ribbon.
- Enter: Created by (your name) 20/02/2012
- Click on [OK] to close the Task Information dialogue box.

To create the second subtask right-click on the ID number 5 to the left of the Decorate task.
- Select New Task from the menu that displays. A new blank row is created.
  - Click within the new cell under the Task Name heading to obtain an insertion point.
  - Enter the name for the new task, which in this case is: Network
  - Press [Enter] to accept the change.
If Project has not made this a subtask of the **Wire room** task, as indicated by it being indented the same as the **Install electrics** subtask:
- Click on the **Task** tab at the left of the **Ribbon**.
- Click on the **Indent Task** button in the **Schedule** group at the centre-left of the **Ribbon**.

Now add a Note to this task stating when it was created. To do this:
- Click on the **Get Skip** task name.
- Click on the **Notes** button in the **Properties** group at the right of the **Task** tab on the **Ribbon**.
- Enter: Created by (your name) 20/02/2012
- Click on [OK] to close the **Task Information** dialogue box.
Creating Dependencies

Establishing Dependencies

- Dependencies are a way to link tasks together in order to describe which tasks must precede or succeed one another – in other words, some tasks must start or finish before another task can begin or end. Creating dependencies allows Project to create a flexible time framework relative to the task preceding or succeeding it.

- There are two types of tasks in a dependency. A predecessor task must occur before another task. A successor task must occur after another task.

To create the Dependencies

- We will begin by making the Empty room task a dependent to the Get skip task. To do this:
  - Double-click on the Empty room task to open the Task Information dialogue box for that particular task.
  - Click on the Predecessors tab.
  - Click in the first row of the Task Name column of the Predecessors tab. A drop-down arrow appears.
  - Select Get skip from the drop-down list that appears.
  - Now click in the first row of the Type column. A drop-down arrow appears.
  - Ensure that Finish-to-Start (FS) is selected from the drop-down menu.
  - Click on [OK] to close the Task Information dialogue box.

- You will notice that the ID number of the predecessor is shown in the Predecessors column of the Gantt table, and that the dependency is represented by an arrow that links the two subtasks in the Gantt Chart.
  
  Note: you may need to use the horizontal scroll bar at the bottom of the Gantt table to view the Predecessors column.

- You will also see that the start and finish dates of the Empty room task have changed, to reflect the fact that it cannot start until its predecessor is finished.

- We will now make the Wire room task dependent on the Empty room task.
  To do this:
  - Double-click on the Wire room Task Name to open the Task Information dialogue box.
  - Click on the Predecessors tab.
  - Click in the first row of the Task Name column of the Predecessors tab. A drop-down arrow appears.
  - Select Empty room from the drop-down list that appears.
  - Now click in the first row of the Type column. A drop-down arrow appears.
  - Ensure that Finish-to-Start (FS) is selected from the drop-down menu.
  - Click on [OK] to close the Task Information dialogue box.

- Similarly, we will make the Decorate task dependent on the Wire room task.
  To do this:
  - Double-click on the Decorate Task Name to open the Task Information dialogue box and then click on the Predecessors tab.
• Click in the first row of the **Task Name** column of the **Predecessors** tab. A drop-down arrow appears.
• Select **Wire room** from the drop-down list that appears.
• Now click in the first row of the **Type** column. A drop-down arrow appears.
• Ensure that **Finish-to-Start (FS)** is selected from the drop-down menu.
• Click on [**OK**] to close the **Task Information** dialogue box.

• Finally, make the **Move in furniture** task dependent on the **Decorate** task. To do this:
  • Double-click on the **Move in furniture** Task Name to open the **Task Information** dialogue box and then click on the **Predecessors** tab.
  • Click in the first row of the **Task Name** column of the **Predecessors** tab. A drop-down arrow appears.
  • Select **Decorate** from the drop-down list that appears.
  • Now click in the first row of the **Type** column. A drop-down arrow appears.
  • Ensure that **Finish-to-Start (FS)** is selected from the drop-down menu.
  • Click on [**OK**] to close the **Task Information** dialogue box.

  • Save the changes by clicking on **Save** in the **Quick Access Toolbar** at the top-left of the screen.

### Creating a Resource List

#### Creating Resources

- Resources are **people, supplies** and **equipment** that you need to use to accomplish your tasks and goals.

- Project uses the resource information you provide to make the **schedule** for your project. Typically, the more resources you assign, the shorter the duration of the project will be because a task is completed faster when there are more people or materials assigned to it.

#### Using the Resource Sheet View

- One of the best ways to enter resources is by using the **Resource Sheet** view, which we will open now. To do this:
  • Click on the **View** tab at the centre-left of the **Ribbon**.
  • Click on **Resource Sheet** (not the down-arrow) in the **Resource Views** group towards the left of the **Ribbon**.

- We will now enter five resources. To do this:
o Click in the first row of the Resource Name column.
o Enter: Porters and then press [Enter].
o We will now add a Note to this stating when it was created, so to do this:
  ▪ Click on the Porters resource name.
  ▪ Click on the Notes button in the Properties group towards the centre of the Properties tab on the Ribbon.
  ▪ Enter: Created 20/02/2012
  ▪ Click on [OK] to close the Task Information dialogue box.

o Now enter the second resource into the second row: Decorator.
o Press [Enter].
o Now enter a Note for Decorator:
  ▪ Click on the Decorator resource name.
  ▪ Click on the Notes button in the Properties group towards the centre of the Properties tab on the Ribbon.
  ▪ Enter: Created 20/02/2012 then click on [OK].

o Enter: Electrician in the third row. Press [Enter].
o Enter a Note for Electrician:
  ▪ Click on the Electrician resource name.
  ▪ Click on the Notes button on the Properties tab on the Ribbon.
  ▪ Enter: Created 20/02/2012 then click on [OK].

o Enter: Networking in the fourth row. Press [Enter].
  ▪ Enter a Note for Networking by clicking on the Networking resource name.
  ▪ Click on the Notes button on the Properties tab on the Ribbon.
  ▪ Enter: Created 20/02/2012 then click on [OK].

o We will now use the Resource Information dialogue box to add the final resource, which is Skip:
  ▪ Double-click in the Resource Name column in the next empty cell below Networking to display the Resource Information dialogue box.
  ▪ Select the General tab.
  ▪ In the Resource name: panel type: Skip
  ▪ Click on the Notes button on the Properties tab on the Ribbon.
  ▪ Enter: Created 20/02/2012 then click on [OK].
o When you have finished click on [OK].

• On entering these details you will notice that Project has assigned some default values to the Resources you have entered into various columns on the right. One of these is the resource Type.
  Project allows you to choose from Work (human resources), Material or Cost as the resource Type. (However do remember that Cost is changed to Material if viewed in Project 2003/XP)

• Therefore, we will change the resource type for Skip to Cost. To do this:
- Click in the **Type** column next to **Skip**. Select **Cost** from the drop-down list that appears.
- Click anywhere away from the cell you have just entered.

- **Save the changes by clicking on **Save** in the **Quick Access Toolbar** at the top-left of the screen.**

### Entering Working Time

**Entering Working Time**

- **Where necessary you can customise a resource’s availability during the project by modifying their project calendar.**

- We find that the **Porters** cannot work tomorrow, and so we need to record this as an **Exception day** in their project Calendar. To do this:
  - Open the **Resource Information** dialogue box by double-clicking on the Resource Name **Porters** in the **Resource Sheet** view.
  - Ensure that the **General** tab is selected.
  - Click on the **[Change Working Time]** button to the right of the dialogue box.
  - Ensure that **Standard** is selected in the **Base calendar**: panel.
  - Ensure that the **Exceptions** tab is selected towards the bottom of the dialogue box.
  - Click on tomorrow’s date in the calendar.
  - Click in the **Name** panel and enter a reason for this restriction. In this case enter: **Not available**.
  - Click within the **Start** panel to display tomorrow’s date.

- **Click on [OK] to close the **Change Working Time** dialogue box.**
- **Click on [OK] to close the **Resource Information** dialogue box.**
Entering Costs

Entering Rates
- It is important to enter rates for a resource, even if they are estimates, as this allows Project to calculate the overall cost of a project.
- The cost of a resource may increase or decrease during the life of your project, and you need to be able to reflect these changes.

- We will just enter some rates for our resource decorator. To do this:
  - In the Resource Sheet view, double-click on the Std. Rate cell for the resource Decorator to display the Resource Information dialogue box.
  - Select the Costs tab.
  - Type 20 in the Std. Rate column.
  - Press [Enter].
  - Type 30 in the Ovt. Rate cell.
  - Press [Enter].
  - Click on [OK] to close the Resource Information dialogue box.

Assigning Resources
- Now we have entered some resources information we can assign our resources to particular parts of the project. To do this:
  - Begin by redisplaying the Gantt Chart by clicking on the View tab at the centre left of the Ribbon.
  - Then click on Gantt Chart (not the down-arrow) in the Task Views group at the left of the Ribbon.
  - If necessary use the horizontal scroll bar at the bottom of the Gantt table so that you can view the Resource Names column.
  - In the Gantt table, click on the Resource Names column for the Get skip task.
  - Select Skip from the drop-down list.
  - Press [Enter] to accept the change.
  - Now click on the Resource Names column for the Empty room task.
  - Select Porters from the drop-down list.
  - Press [Enter] to accept the change.
  - Note: You should notice that the Start date has changed to reflect that the Porters cannot work tomorrow.
  - Similarly click on the Resource Names column for the Install electrics task.
  - Select Electrician from the drop-down list.
  - Press [Enter] to accept the change.
- Click on the **Resource Names** column for the **Network** task.
- Select **Networking** from the drop-down list.
- Press **[Enter]** to accept the change.

- Another way of achieving this is by using the **Task Information** dialogue box. To use this method:
  - Scroll to the left again if necessary to view the **Task name** column, and then double-click on the **Decorate** task to open the **Task Information** dialogue box.
  - Click on the **Resources** tab.
  - Click within the first blank cell below the **Resource Name** heading and then click on the down-arrow that appears to the right of the panel.
  - Select **Decorator** from the drop-down list.
  - Click **[OK]** to close the dialogue box.

- You will notice that the names of the resources that you have assigned have appeared in the **Gantt Chart** to the right of the tasks to which they relate.

- Save the changes by clicking on **Save** in the **Quick Access Toolbar** at the top-left of the screen.
Working with Baselines

Understanding Baselines

- The baseline is a picture or image you capture of the project plan the moment planning is complete. It provides a point of reference when tracking your project, and is used to track the planned progress of the project against the actual progress.

Setting the Baseline

- To set the project’s baseline:
  - Click on the Project tab towards the left of the Ribbon.
  - Click on Set Baseline in the Scheduling group at the centre of the Ribbon to display a menu.
  - Select Set Baseline to display the Set Baseline dialogue box.
  - Ensure that the Set Baseline check box displays a check mark.
  - In this case we want to record the entire project, so ensure that the Entire project check box under the For: heading displays a check mark.
  - Click [OK] to save the baseline information and close the dialogue box.

Recording Actuals - Tasks

- Once a project is underway, it is important to collect and record data on task progress to show what has actually occurred. This allows Project to automatically reschedule the remaining tasks and gives tangible ways to measure progress (when compared to the baseline).

Setting Actual Start and Finish Dates

- Recording the actual start or finish date of a task is critical to the overall finish date of the project. If tasks finish on time, the project is likely to finish on time, and conversely, if they complete behind schedule, the project is likely to finish behind time.
We will now record the actual start date of the task we are working on, as for the purpose of this scenario, we cannot get the skip until tomorrow. To do this:

- Click on the **Task** tab at the left of the **Ribbon**.
- Click on the **Display Task Details** button at the right of the **Properties** group on the **Ribbon**.

  - The **Task Details Form** appears in the bottom half of the screen.
  - In the top pane of your screen, select the **Get skip** task by clicking on it.
  - In the bottom pane, choose **Actual** from the option buttons at the bottom of the **Dates** panel.

- Use the **Start** drop-down calendar in the **Dates** section to select tomorrow’s date as the actual start date.
- Click on the [**OK**] button to update the **Gantt table**.

**Actual Task Durations**

- In a similar way, it is possible to record the actual duration of tasks, which we will do now. To do this:
  - In the **Gantt Chart** view at the top of your screen, select the task you would like to update. In this case, we will select **Install electrics**.
  - Click on the **Task** tab at the left of the **Ribbon**.
  - Click on the down-arrow to the right of the **Mark on Track** button in the **Schedule** group at the centre of the **Ribbon** to display a menu.

  - Select **Update Tasks** to display the **Update Tasks** dialogue box.

- We want to update the **Actual dur:** panel to show that this task took **1.5 days** rather than **1 day** as expected. To do this:
  - As a **1.5 day** option is not available from the panel’s up/down arrows click and drag across the existing entry in the **Actual dur:** panel to select it and then overtype it with the actual duration, which is: **1.5**
  - Click [**OK**] to accept the change.
You should notice a checkmark has appeared in the Information column next to the Install electrics task in the top half of the screen, indicating that the task has been completed.

You should also notice that the duration has changed to 1.5 days, and that subsequent dates have been altered to reflect that this part of the project took longer than originally planned.

- We no longer need the Task Details Form, therefore to remove it and view the Gantt Table and Chart in full screen mode:
  - Click on the Task tab at the left of the Ribbon.
  - Click on the Display Task Details button at the right of the Properties group on the Ribbon.

- Save the changes by clicking on Save in the Quick Access Toolbar at the top-left of the screen.

### Tracking with the Tracking Gantt View

#### Utilizing the Tracking Gantt View

- The Tracking Gantt view is perhaps the most complete picture of your project’s progress. It lets you gain an effective perspective on the actual progress compared to your original estimates (the baseline).

- We will view the Tracking Gantt view now, to do this:
  - Click on the View tab at the centre-left of the Ribbon.
  - Click on the down-arrow below the Gantt Chart button in the Tasks Views group at the left of the Ribbon.
  - Select Tracking Gantt from the menu that displays.
  
    **Note:** you may need to use the scroll bar at the base of the Tracking Gantt Chart on the right side of your screen to scroll to the left and view the project information.

- The pane on the right shows the Tracking Gantt Chart.
  - Blue bars represent non-critical tasks.
  - Red bars represent critical tasks.
  - The bars appear solid if the task is complete, and as hatching if it is not yet complete.
  - Grey bars represent the baseline.
  - Percentages of work complete are shown to the right of the bar.

- That completes our work on this project, so close the file, by clicking on its lower grey Close button . When the dialogue box appears asking you if you would like to save your changes, choose [No].
Appendix

The following sections cover some additional areas that may be useful when using Project.

Changing the Working Time within a Project

- Project’s default Working Time is set to be an eight hour day Monday to Friday.
- This can be changed, for example to set the standard working day for all workers to be a seven hour day.
- However, for this to be picked up by the calendars created within a project, e.g. those for each resource, this needs to be set before any tasks have been created. If this is not done, you will have to individually modify each calendar.

- To set the Working Time to be 09:00 until 17:00 Monday to Friday:
  - Close any projects that you have open (to ensure that Project does not get confused).
  - Create a new project and save it.
  - Click on the Project tab towards the left of the Ribbon.
  - Click on Change Working Time in the Properties group towards the centre-left of the Ribbon to display the Change Working Time dialogue box.
  - Ensure that the For calendar: panel displays Standard (Project Calendar).

- Click on [Options] at the bottom of the dialogue box to display the Project Options dialogue box.
- Click on Schedule in the left-hand column.
- From the Calendar options for this project: drop-down list select the name of the project you are working on.
  **Note:** Selecting All New Projects will result in the changes you are making being applied to every new project you create.

- Change the Default start time: panel to 09:00
- Ensure that the Default end time: panel displays 17:00
- As Project does not automatically update the daily hours, change the Hours per day: panel to 7
- Similarly, change the Hours per week: panel to 35
- Click on [OK] to close the Project Options dialogue box.
Project does not automatically feed these changes into the Standard Calendar (probably because the Calendar existing before the changes were made). Therefore to apply the changes:

- Ensure you are viewing the **Change Working Time** dialogue box.
- Click on the **Work Weeks** tab and then click on [Details] at the left of the dialogue box to display the Details for ["Default"] dialogue box.

- Hold down the [Ctrl] key at the bottom left of the keyboard and with it still depressed select each day that the change is to affect, which in this case is **Monday** through to **Friday**. Release the [Ctrl] key when you have finished.

- Ensure that the **Set day(s) to these specific working times** check box displays a check mark.
- In the table displaying the working times change the **From** time in row 1 to **09:00**
- Click on [OK] to close the Details for ["Default"] dialogue box.
- Click on [OK] to close the Change Working Time dialogue box.

### Changing a Resource to Include Specific Overtime

Using the **Change Working Time** dialogue box you can add specific additional days and times, for example to register a resource’s overtime.

In this case we will examine how to add a Saturday as an overtime day. To do this:

- Ensure that you are viewing the project you wish to change, and the Resource for which you wish to add overtime has already been created.

- Click on the Project tab towards the left of the Ribbon.
- Click on Change Working Time in the Properties group towards the centre-left of the Ribbon to display the Change Working Time dialogue box.
• Change the **For calendar**: drop-down list to the name of the Resource you wish to affect.

• In the Calendar at the centre of the dialogue box, click on the date that you wish to record as an Overtime day.

• This overtime is an exception to the normal working week hours, Therefore click on the **Exceptions** tab.

• Click in the **Name Panel** and enter a reason for this additional work hours, e.g. Saturday overtime.

• Click in the cell to the right under the **Start** heading to automatically enter the Start and End date that you selected on the Calendar.

![Change Working Time](image)

• Click on [Details] at the left of the dialogue box to display the **Details for [‘Default’]** dialogue box.

• You need to specify that this is a working time, therefore click within the **Working times**: check box so that it displays a check mark.

• Ensure that the **From** and **To** table displays the correct working times for the overtime being worked.

• As we are recording a one-off period of overtime also ensure that:
  o The **Daily** check box displays a check mark.
  o The **Start** date is correct.
  o The **End after**: check box displays a check mark and the **occurrences** panel displays 1.

• When you have finished click on [OK] to close the **Details for ...** dialogue box.

• Click on [OK] to close the **Change Working Time** dialogue box.
Shutting Down

- We have finished our work for now, so close Project by clicking on its Close button. Select [No] if you are prompted to save any changes.
- Ensure that all programmes are closed and then exit from Windows XP and log off from the system.

Conclusion

During today’s session we have considered some of the main features of Microsoft Project 2010, including how to enter and modify tasks and their durations, how to create dependencies between tasks, and how to create resources and assign them to tasks.

We have also considered some elementary ways in which projects can be updated and tracked, for example by setting the baseline, and recording actual start and finish dates and actual task durations.